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About this Help Sheet 
 
This help sheet will help you get started in using Outlook 2000. It is designed for those 
that are new to Outlook 2000 and includes instructions on how to use some of the basic 
features of the e-mail software.  
 

Starting Outlook 2000 
 
In this lesson you will learn how 
Outlook viewer screen. 
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Outlook 2000 Viewer Screen    (Continued) 
 
 

     
 
 
 
 
 
 
 

Clicking on the Inbox icon 
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inside the information viewer. 
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Reading New Mail Messages        
 
In this lesson, you will learn how to open a
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      every new mail message in your Inbox.) 
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Sending an E-mail Message 
 
In this lesson, you will learn how to send an e-mail message. 
 
 
1.   On the Message toolbar, click the New Mail Message button.   

 
A blank message form appears (Refer to Illustration 1-5). 

 

 New Mail Message button 

Send button  
Message 
   header 
 

 
 

1. In the To: box, type in the e-mail address of the person next to you, then Tab down t
the Subject: box. 

 
2. In the Subject: box, type this subject: Test message from Your Name Here  
 
3. Tab down into the Message area and type this message:  
 

 
 
 

 
 
 
5.    When your message is complete, click on the Send button and your message will be
       delivered to it’s recipient. 

Welcome to the Outlook 2000 training session for staff members at Pitzer College. 
 
Sincerely, 
Your Name Here 

Message 
       area 

Illustration 1-5 
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Mail Sending Options 
 
You can define how e-mail is sent by setting the e-mail options before sending your 
message. To do that, simply click on the Options button on the Message toolbar and a 
dialog box with several options will open up (Refer to Illustration 1-6). 
 
 

 
 
 
Under the Message settings option, you can set the importance or sensitivity of your 
message to low, normal or high priority by dropping down the menu and clicking on one 
of the choices.  
 
 
Under the Voting and Tracking options, you can put a check in the box by clicking in it 
with your mouse and set it so that you receive a notice that your message has been 
delivered and when it has been read. 
 
 
Under the Delivery options, you can specify where you would like a copy of your sent 
messages to be filed. As a default, it is set to file your sent messages in a folder named 
Sent Items. 
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When you are satisfied with the settings, click on the close button and you will return to 
your message at which time you are ready to send. 
 
 

Replying to an e-mail message 
 
In this lesson you will reply to an e-mail message that is currently in your Inbox. 
 
1. In the Information viewer, double click on the e-mail message that you wish to reply 

to so that a copy of the message is displayed.  
 
2. On the Message toolbar, click on the Reply button. 
 
     A form will open listing the original senders name in the To: box, in regard to 
     statement in the Subject: box and the original header and message is located in the 
     Message area. (Refer to Illustration 1-7) 
 
 
 

 
 
 
3. At this point you can begin typing your reply to this message in the Message area. 
 
4. When your reply message is complete, click on the Send button and your message 

will be delivered to the original sender. 

Illustration 1-7 
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Forwarding An E-mail Message    
 
In this lesson, you will learn how to Forward an e-mail message to another recipient. 
 
1. In the Information viewer, double click on the e-mail message that you wish to 

forward so that a copy of the message is displayed. 
 
2. On the Message toolbar, click the Forward button.  
 

A form will open listing a forward indicatior in the Subject: box and the original 
header and message in the Message area. (Refer to Illustration 1-8) 
 

  
 
 
3. Type the name of the recipient in the To: box then tab down to the Message area. 
 
4. Start typing in anything you wish to add to the message prior to sending it. 
 
5. When you’ve finished your additions to the message, click on the Send button and 

the message will be forwarded to the recipient.  
 

 

 
 Forward button 
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Organizing Messages In Folders 
 
In this lesson, you will learn how to move read e-mail messages into specific folders 
that you create.  
 
1. Take you mouse pointer and click once on a read e-mail message so that it is 

highlighted. 
 
2. On the Standard toolbar, drop down the Edit menu and click on the Move to 

Folder command and a Move Items window will pop up like the one shown in 
Illustration 1-9. 

 

 
Move to 
Folder 
icon 
  

        

 
 

 
       At this point you will be creating a new sub folder inside the Inbox folder. 
 
3. Click on the New…  button to create a new sub folder and a Create New Folder 

window will pop up. 
 
 
4. In the Name box, type in the word Test then click on the OK button. A message will 

pop up asking if you would like to add this folder to your Short Cut bar, click No. 
You will then be taken back to the Move Items window where you hit OK if 
everything is correct and your message is now moved to your new Test folder. 
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How To View Archived Messages 
 
In this lesson, you will learn how to locate filed messages using the Folder List. 
 
1. Be sure the Inbox is displayed in the Information viewer. 
 
2. On the Folder banner, click the arrow next to the word “Inbox”. The Folder List is 

displayed on the left side of the Information viewer. 
 
3. Click the Push Pin icon in the upper-right corner of the Folder List. The Push Pin 

icon turns into a Close button, and the Folder List is temporarily fixed in place. 
(Refer to Illustration 1-10) 

 

 
    
 
 
4.   Click once on the “+” next to the Inbox to display the subfolders within the Inbox    
      folder.  Click once on the subfolder that contains the message you would like to  
      locate and notice that all the messages contained in that subfolder are now listed in 
      the Information viewer on the right. 
 
5. You can now open the message and read it, reply to it or forward it to someone else. 
 
6. To close the Folder list, click on the Close button in the upper-right corner and then 

click on the Inbox icon in the Short Cut bar. 
 

 
 

 
Push Pin 
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Attachments 
 
Viewing An Attachment Message 
 
In this lesson, you will learn how to view an attachment. Messages with attachments 
have a paper clip symbol in front of them in the Information viewer. (Refer to 
Illustration 1-9) 
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1. Double-click on the message containing the attachment so that a copy of the message 

is displayed. 
 
2. Double-click the attachment icon. 
 

The document will open in a Microsoft Word window. 
 

3. When you are done reading the attachment, close Word and then close the message 
window and you will return to your Inbox. 

 
 
Sending A Message With An Attachment 
 
In this lesson, you will learn how to attach a file to a message. 
 
1. Be sure that you have opened a blank message form and filled in the To: , Cc: and 
       Subject boxes in the message header. 
 
2. Click in the Message area type in a brief message that will accompany the 

attachment. 
 
3. When you are done with your brief message, click the attachment icon on the 

Message toolbar.  
 
 
 
4. An Insert File dialog box will open. Click the arrow in the Look In box and select the 

drive that your document is located in, then locate which folder it is filed in. When 

chment 
bol 
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you have found you document, highlight it and click OK and the document will be 
inserted into your letter as an icon. (Refer to Illustration 1-12) 
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5. Click the send button and your message, along with your attachment, will be sent to 

the recipient. 
 
 
 
Deleting An E-mail Message 
 
When you delete an e-mail message, it is ta
into the trash bin. This is meant as a securit
deleted and lost forever. The first lesson is 
recovering it or permanently deleting it. 
 
 
In this lesson, you will learn how to delet
 
1. If you have a message that is opened, si

toolbar and and the message will be mo
 

2. If you are looking at the message in the
message once to highlight it and then cl
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In this lesson, you will learn how to recov
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ick on the delete icon on the toolbar and it 
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1. To retrieve a deleted message, open the Deleted items folder by clicking the Deleted  
       items short cut on the Outlook bar. (Refer to Illustration 1-13) 
 

 
 
 
 
2. You are now inside the Deleted items folder. From here you can move messages to 

other folders or permanently delete messages by clicking on the Delete icon. 
 
3. When you are finished viewing your Deleted items folder, scroll up the Short cut bar 

and click on your Inbox. 
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Viewing your Calendar 
 
In this lesson, you will learn how to view your Calendar, create appointments and 
how to share your Calendar with others. 
 
 
1. On your Outlook Short cut bar, click on the Calendar icon and you will see the  
       following window:  
 
 
 
 

Folder 
banner 

Date  
navigator 
Appointment 
       area 
  

 
2. At this point, lets create an appointment three months from today and setup a 

reminder to notify you one hour prior to the start of the appointment. Click on the 
arrow in the Date Navigator to scroll to the upcoming month until you are three 
months from today.  

 
3. In the Date Navigator, put your mouse pointer on the day that the appointment is on 

and click once on it. In the Appointment area, notice that the date at the top has now 
changed to the date that was chosen. 

Task 
pad 



 

  

4. In the Appointment area, put your mouse pointer in the 10:00 am box and double 
click the your mouse button to open up a window similar to Illustration 1-14. 

 
 

5.    In the Subject box, type in “ Meeting  with department supervisor ” then tab down to  
       the next line.  
 
6. In the Location box, type in “ Conference room B ”. 
 
7. Put your mouse pointer and put it in the Chime check box and click once on the 

mouse button putting a check mark inside it. The Reminder box to the right of it is 
now active.   

 
8. Click on the down arrow in the Reminder box and choose “ 30 minutes ” . The 

reminder function has now been set and a message will pop up 30 minutes prior to 
your meeting reminding you of your scheduled appointment. 

 
9. If everything looks correct, click on the Save and Close button on the tool bar and 

you will return to your Calendar viewer with your newly scheduled appointment 
showing on it.     

 
 
 
 
 
 
 

Illustration 1-14 



 

  

Setting Calendar Permissions 
 
In this lesson, you will learn how to set the Calendar permissions so that you can 
allow other people to view or edit your personal calendar. 
 
1. On your Outlook Short Cut bar, place your mouse pointer on the calendar icon and 

click on the right mouse button. A menu will appear, move your mouse pointer down 
to Properties and click your left mouse button so that the Calendar Properties 
dialog box is displayed. 

 
2. Click on the Permissions tab to bring it forward. Click on the Add button, then 

highlight the name of the person you wish to make your calendar viewable to and 
click on the Add button to move them over to the column on the left. Then click OK. 

 
3. Click once on the name you just added to your permissions list and then choose the 

type of permissions this person will have below.  
 
4. You can drop down the menu and choose the type or you can specify the type by 

placing checkmarks into the boxes in the Permissions table. 
 
5. When you have completed setting the permissions, click OK and then the person you 

added can now see your calendar. 
 
 
 
Viewing another person's Calendar 
 
If you have been given permission to view someone's calendar, please follow these steps 
to open the calendar. 
 
1. Click on the File menu and go to Open, then click once on Other User's Folder… 

to open the Other User's Folder dialog box. 
 
2. Click on the Name… button to open the Select Name dialog box. 
 
3. Highlight the name of the person who's calendar you wish to open and click on OK. 

You will return to the Other User's Folder dialog box with the name in the top box.  
 
4. Drop down the menu in the Folder box and choose Calendar then click OK and the 

Calendar will open. 
 
 
Setting Appointment Recurrences 
 
1. In the Date Navigator, click on tomorrows date and in the Appointment area double 

click on the 12:00 P.M. block to open an appointment form. 

 



 

 

2. Type Lunch in the Subject box and type your favorite restaurant in the Location 
box, then click on the Recurrence button on the tool bar. 

 
An Appointment Recurrence dialog box appears. 
You can set the recurrence to happen daily, weekly, monthly or yearly and you can 
set it up for specific days only and you can also set it up to start and end on a 
specified date. 
 

3. After setting up your Recurrence box, click OK and then Save and Close your 
Appointment form and your recurrence is set. 

 
 
 
Personal Address Book 
 
In this lesson, you will learn how to add contacts to your Personal Address Book. 
 
1. On the Message toolbar, click the Address Book Button.  
       The Address Book dialog box will appear. 
 
2. Be sure the Personal Address Book appears in the Show Names From The box. 

(Illustration 1-15) 
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 look like Illustration 1-16.  



 

 

                         
 
 
 
4. Click Internet Address and 
 
5. Add the Display name and E

to your Personal Address Bo
 
6. Close the Address Book dial
 
 
Personal Distribution L
 
In this lesson, your will learn ho
to your Personal Address Book
 
 
1. On the Message toolbar, clic
       The Address Book dialog bo
 
2. Click the New Entry button.

The New Entry dialog box a
 
3. In the Put this entry box, us

as shown in Illustration 1-17
 
 

Illustration 1-16 
 

click OK. 

-mail address and then click OK. The name is added 
ok. 

og box. 

ists 

w to create a Personal Distribution List and add it 
. 

k the Address Book Button.  
x will appear. 

 
ppears. 

e the drop down box to select Personal Address Book 
 and then click OK. 
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button. 

 
5. Click on the Add/Remove M

The Edit New Personal Distr
 
6. Click once on the person you 

them into the column on the le
people you wish to be on this 
everyone, click OK. 

 
7. In the New Personal Distribu

Your new distribution list has
 

 
Creating Signatures 
 
To create signatures, you must b
 
1. Using your mouse, click on th

that the Options dialog box o
 
2. Click on the Mail Format tab

Illustration 1-18. 
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embers button. 
ibution List Members dialog box appears. 

wish to add, than click on the Members button to add 
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tion List Properties dialog box, click OK. 
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e in your Inbox. 
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 to bring it forward. Your screen should now look like 



 

 

                      
 
 
3. Click on the Signature Picker button near the bottom of this dialog box. 
 
4. In the Signature Picker dialog box, click on the New button. 
 
5. Enter a name for your signature then click on the Next button at the bottom of the 

dialog box. Your screen should now look like illustration 1-19. 
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6. Begin entering your name, title, phone number, etc…. When you have completed 
your signature click on the Finish button at the bottom. You will be taken back to the 
Signature Picker dialog box, click OK to close this box then click OK to close the 
Options dialog box. 

 
7. To use the signature feature, open a new mail message form then click on the Insert 

menu and go to Signature then click once on the signature you created to add it into 
your e-mail. 

 
 
 
Using Contacts 
 
In this lesson, you will learn how to add a contact to your Contacts list. 
 
 
1. On the Standard tool bar, click the New Contact button (Illustration 1-20). A blank 

contact form appears.  
 

                
 
 
 

2. In the Full Name box, type the nam
press TAB. The insertion point mo
automatically inserted in the File A

 
3. Fill in the Company, Phone number

form, click the Save and Close but
added to your Contacts list. 

New 
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s box. 

s and E-mail boxes. When you've completed the 
ton on the tool bar and the form has now been 



 

 

Open a new mail form and click on the To: button then drop down the Global list and 
choose Contacts and the new contact can be inserted into your email message. 
 
 

Creating a Personal Distribution List in the Contacts address book 
 

1. On the standard toolbar click the drop down arrow next to the New button 
(Illustration 1-21) and click on Distribution List. 
 

               
 
 
 

2. The Distribution List dialog box o
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it. 

 
3. Click Select Members. In the Sho
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5. Click Save and Close. 
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1. On the Tools menu, click Out of Office Assistant. The Out of Office Assistant 

dialog box opens (Illustration 1-22). 
 

               
 
 
 
2. Select the I Am Currently Out 
 
3. Click in the AutoReply Only O

box, and then type your message
 
4. Click OK. 
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Useful Features 



 

 

Notes 
 
In this lesson, you learn how to create a reminder note. 
 
1. On the Outlook Shortcut bar, click on the Notes shortcut icon. 
 
2. On the Standard tool bar, click on the New Note button. 

A blank yellow note is displayed. 
 

3. Type a brief message on the note then click on the X on the upper right corner to 
close. 
 
The note closes and the note icon is displayed on the information viewer. 
 
 
 

Stationary 
    
1. While viewing your Inbox, click on the Actions menu and choose New Mail 

Message Using and click on More Stationary. 
 
The Select A Stationary dialog box will appear (Illustration 1-23). 
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2. Scroll through the different stationary forms and select one and click OK. 
 
3. Complete as you would a normal mail form and send a fun letter to a friend. 
 
 
 
Advanced Find    
    
In this lesson, you will learn how to do a search for a specific email message. 
 
1. Click on the Tools menu and click on Advanced Find. 
 

The Advanced Find dialog box will appear (Illustration 1-24). 
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Recalling A Message 
    
In this lesson, you will learn how to recall a message that you have sent out. 
 
1. Open the Sent Items folder and then find the message you wish to recall and open it 

by double clicking on it. 
 
2. Click on the Actions menu and click on Recall This Message... 
 

The Recall This Message dialog box opens (Illustration 1-25). 
 

                  
 
 

3. You have two options, Delete u
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Remote Access to Outlook through a browser. 
    
In this lesson, you will learn how to access Outlook through the Internet. 
 
1. Connect to the Internet and launch your browser. 
 
2. In the Location box, type http://www.pitzer.edu/email then hit Enter. 
 
3. You will now be at a site called: Microsoft Outlook Web Access. In the text box, 

type your user name then hit Enter. A Username and Password Required dialog 
box will appear, enter your username and password then hit Enter. 
 
You should now have access to Outlook on the web. 
 


	Using Outlook 2000 (Windows)
	Pitzer College Information Technology
	About this Help Sheet
	This help sheet will help you get started in using Outlook 2000. It is designed for those that are new to Outlook 2000 and includes instructions on how to use some of the basic features of the e-mail software.
	Starting Outlook 2000

	Outlook 2000 Viewer Screen
	Outlook 2000 Viewer Screen (Continued)
	Reading New Mail Messages
	In this lesson, you will learn how to open and read a new e-mail message
	Sending an E-mail Message
	In this lesson, you will learn how to send an e-mail message.
	
	Mail Sending Options


	Replying to an e-mail message
	Forwarding An E-mail Message
	Organizing Messages In Folders
	How To View Archived Messages
	Attachments
	Viewing An Attachment Message
	Sending A Message With An Attachment
	Deleting An E-mail Message
	Viewing your Calendar
	Setting Calendar Permissions
	
	
	Viewing another person's Calendar
	Setting Appointment Recurrences



	Personal Address Book
	Personal Distribution Lists
	Creating Signatures
	Using Contacts
	Out of Office Assistant

	Create Rules for the Out of Office Assistant
	More Useful Features
	Notes
	Stationary
	Advanced Find
	Recalling A Message
	Outlook Today
	Remote Access to Outlook through a browser.


